
SESSION ONE: DESCRIBING MOTION WITH WORDS AND GRAPHS 

Distance vs. Time Graphs of Your Motion
In this session you will examine two different ways that the mo-
tion of an object can be represented graphically: first you will use 
a motion detector to create distance (position) vs. time graphs of 
the motion of your own body and then you will create velocity vs. 
time graphs. 
 

Figure 1: Walking in front of a motion detector attached to a Computer-
based Laboratory (or CBL) system.

The purpose of the first activity in this session is to learn how to 
relate graphs of distance as a function of time to the motions they 
represent.

How does a distance vs. time graph look when you move slowly? 
Quickly? What happens when you move toward the motion detec-
tor? Away? After completing the next few activities, you should be 
able to look at a distance vs. time graph and describe the motion 
of an object. You should also be able to to look at the motion of an 
object and sketch a graph representing that motion.

Note:
•"Distance" means "distance from the motion detector." 
• The motion detector is located at the origin of each graph.

To do the activity and those that follow you should double check to 
see that: (1) a LabPro is connected to the computer, is turned on 
and has a motion detector plugged 
in, and (2) that the Logger Pro program on your computer has 
been opened.

✍Activity 3-1: Making Distance vs. Time Graphs
 Make distance-time graphs for different walking speeds and directions 
by clicking on the start button at the bottom of the screen and walking in 
front of the motion detector at distances that are no closer than 0.5 m. 
Try the following motions and sketch the graph you observe in each case:
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(a) Start at 0.3 m walk away from 
the origin (i.e., the detector) slowly 
and steadily. 

(b) Walk away from the origin me-
dium fast and steadily. 

(c) Walk toward the detector (ori-
gin) slowly and steadily. Sketch 
the graph.

(d) Describe the difference between the graph you made by walking away 
slowly and the one made by walking away more quickly.

(e) Describe the difference between the graph made by walking toward 
and the one made walking away from the motion detector.

Note: It is common to refer to the distance of an object from some origin 
as the position of the object. Since the motion detector is at the origin of 
the co-ordinate system, it is better to refer to the graphs you have made 
as position vs. time graphs.

Predicting the Graph of a Motion Described in Words 
A good way to double check that you understand how to interpret 
position vs. time graphs is to predict the shape of a graph that 
would result if a motion that can be described in words and then 
carry out the motion. 

✍Activity 3-2: Predicting a Position vs. Time Graph
(a) Suppose your were to start 1.0 m in front of the detector and walk 
away slowly and steadily for 4 seconds, stops for 4 seconds, and then 
walk toward the detector quickly. Sketch your prediction on the axes 
below using a dashed line. 
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(b)Test your prediction by opening the RTP experiment file L1A1-1 
(Away and Back). (Select Open on the File menu, and double click 
with the mouse pointing to this experiment.) Move in the way described 
and use the graph above to sketch the actual trace of your actual motion 
with a solid line.

(c) Is your prediction the same as the final result? If not, describe how 
you would move to make a graph that looks like your prediction. 

Matching Position vs. Time Graphs
Can you turn the activity you just did inside out? We'd like you to 
be able to look at a graph and then be able to describe the motion 
it depicts in words. The real test is to be able to reproduce the mo-
tion correctly.

✍Activity 3-3: Matching Position vs. Time Graphs
(a) To do the first matching activity you should Open the experiment file 
called L1A1-2 (Position Match). A position graph like that shown on 
the following graph should appear on the screen. (This graph is stored in 
the background as data B so you will be able to move in front of the de-
tector and see your graph (as data A) traced out on top of the trace you 
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are to match.) 
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(b) Describe in your own words how you plan to move in order to match 
this graph.

(c) Move to match the Position Match graph on the computer screen. 
You may try a number of times. It helps to work in a team. Get the times 
right. Get the positions right. Do this for yourself. (Each person in your 
group should do his or her own match.) You will not learn very much by 
just watching!

(d) What was the difference in the way you moved to produce the two 
differently sloped parts of the graph you just matched?

(e) Make curved position vs. time graphs like those shown below.
Note: Before trying to reproduce the shapes shown below, get rid of the 
graph you just matched by choosing "Hide Data B" from the data menu 
in the Motion software.

T i m e
 !

T i m e
 

Graph 1 Graph 2
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(f) Describe how you must move to produce a position vs. time graph 
with each of the shapes shown.

 Graph 1 answer:

 
 Graph 2 answer:

 

(g) What is the general difference between motions which result in a 
straight line position vs. time graph and those that result in a curved-
line position vs. time graph?

30 min
Velocity vs. Time Graphs of Your Motion
You have already plotted your position as a function of time. An-
other way to represent your motion during an interval of time is 
with a graph which describes how fast and in what direction you 
are moving from moment to moment. How fast you move is known 
as your speed. It is the rate of change of position with respect to 
time. Velocity is a quantity which takes into account your speed 
and the direction you are moving. Thus, when you examine the 
motion of an object moving along a line, its velocity can be positive 
or negative meaning the velocity is in the positive or negative di-
rection.

Graphs of velocity over time are more challenging to create and 
interpret than those for position. A good way to learn to interpret 
them is to create and examine velocity vs. time graphs of your 
own body motions, as you will do in the next few activities. You 
will need the following:

! • Logger Pro software 
! • Motion detector
! • LabPro Interface 
! • Number line on floor in metres (optional) 

To do the next few activities you should Open the motion software 
and set it to graph velocity. To do this you can double click any-
where on the position graph to display a dialogue box. Move the 
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mouse pointer to the Position label, hold down the button and se-
lect Velocity. Set the Velocity axis from –1.0 to +1.0 m/s. Also 
change the Time axis to read 0 to 5 s.

✍Activity 3-4: Making Velocity vs. Time Graphs

Note: To change the 
scale of your graph so 
the trace fills the 
screen better, double 
click on the original 
graph and use the dia-
logue box that pops up 
to choose a different 
maximum and mini-
mum velocity

(a) Make a velocity graph by walking away from the detector 
slowly and steadily. Try again until you get a graph you're satis-
fied with and then sketch your result on the graph that follows. 
(We suggest you draw smooth patterns by ignoring smaller 
bumps that are mostly due to your steps.). 

 
(b) Make a velocity graph, walking away from the detector steadily at a 
medium speed. Sketch your graph below.
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(c) Make a velocity graph, walking toward the detector slowly and stead-
ily. Sketch your graph below.
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(d) What is the most important difference between the graph made by 
slowly walking away from the detector and the one made by walking 
away more quickly? 

(e) How are the velocity vs. time graphs different for motion away and 
motion toward the detector?
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Predicting Velocity vs. Time Graphs Based on Words
Suppose you were to undergo the following sequence of motions:
1. walk away from the detector slowly and steadily for 6 seconds

2. stand still for 6 seconds

3. walk toward the detector steadily about twice as fast as before

✍Activity 3-5: Predicting a Velocity vs. Time Graph
(a) Use a dashed line in the graph that follows to record your prediction 
of the shape of the velocity graph that will result from the motion de-
scribed above.
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(b) Compare predictions with your partner(s) and see if you can all 
agree. Use a solid line to sketch your group prediction in the graph 
above.

(c) Adjust the time scale to 15 s in the Motion Software and then test 
your prediction. Repeat your motion until you are confident that it 
matches the description in words and then draw the actual graph on the 
axes below. Be sure the 6-second stop shows clearly.

Final Result    
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1. (d) Did your prediction match your real motion? If not what misun-
derstanding of what the elements of the graph represent did you 
have? 

 

Comments about Velocity Graphs: 
(1) Velocity implies both speed and direction. How fast you move 
is your speed, the rate of change of position with respect to time. 
As you have seen, for motion along a line (e.g., the positive x-axis) 
the sign (+ or -) of the velocity indicates the direction. If you move 
away from the detector (origin), your velocity is positive, and if 
you move toward the detector, your velocity is negative.

(2) The faster you move away from the origin, the larger positive 
number your velocity is. The faster you move toward the origin, 
the "larger" negative number your velocity is. That is -4 m/s is 
twice as fast as -2 m/s and both motions are toward the origin.

Velocity Vectors:
These two ideas of speed and direction can be combined and rep-
resented by vectors.

A velocity vector is represented by an arrow pointing in the direc-
tion of motion. The length of the arrow is drawn proportional to 
the speed; the longer the arrow, the larger the speed. If you are 
moving toward the right, your velocity vector can be represented 
by the arrow shown below.

If you were moving twice as fast toward the right, the arrow rep-
resenting your velocity vector would look like:
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while moving twice as fast toward the left would be represented 
by the following arrow:

What is the relationship between a one-dimensional velocity vec-
tor and the sign of velocity? This depends on the way you choose 
to set the positive x-axis. 

0 +

Positive velocity

Negative velocity
0+

Positive velocity

Negative velocity

In both diagrams the top vectors represent velocity toward the 
right. In the left diagram, the x-axis has been drawn so that the 
positive x-direction is toward the right. Thus the top arrow repre-
sents positive velocity. However, in the right diagram, the positive 
x-direction is toward the left. Thus the top arrow represents nega-
tive velocity. Likewise, in both diagrams the bottom arrows repre-
sent velocity toward the left. In the left diagram this is negative 
velocity, and in the right diagram it is positive velocity.

✍Activity 3-6: Sketching Velocity Vectors
 Sketch below velocity vectors representing the three parts of the motion 
described in the prediction you made in Activity 3-5.

(a) Walking slowly away from the detector:

(b) Standing still:

(c) Walking rapidly toward the detector:

Velocity Graph Matching
In the next activity, you will try to move to match a velocity graph 
shown on the computer screen. This is often much harder than 
matching a position graph as you did in the previous investiga-
tion. Most people find it quite a challenge at first to move so as to 
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match a velocity graph. In fact, some velocity graphs that can be 
invented cannot be matched! To do this activity 
pull down the File Menu and select Open. Then double click on 
L1A2-2 (Velocity Match). The following velocity graph should 
appear on the screen.
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✍Activity 3-7: Matching a Velocity Graph
(a) Describe how you think you will have to move in order to match the 
given velocity graph.

(b) Move in such a way that you can reproduce the graph shown. You 
may have to practice a number of times to get the movements right. 
Work as a team and plan your movements. Get the times right. Get the 
velocities right. You and each person in your group should take a turn. 
Then draw in your group's best match on the axes that follow.
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(c) Describe how you moved to match each part of the graph.
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(d) Is it possible for an object to move so that it produces an absolutely 
vertical line on a velocity time graph? Explain. 

(e) Did you run into the motion detector on your return trip? If so, why 
did this happen? How did you solve the problem? Does a velocity graph 
tell you where to start? Explain. 

35 min
Relating Position and Velocity Graphs
You have looked at position and velocity vs. time graphs sepa-
rately. Since position vs. time and velocity vs. time graphs are dif-
ferent ways to represent the same motion, it ought to be possible 
to figure out the velocity at which someone is moving by examin-
ing her/his position vs. time graph. Conversely, you ought to be 
able to figure out how far someone has travelled (change in posi-
tion) from a velocity vs. time graph.

To explore how position vs. time and velocity vs. time graphs are 
related, you will need the following:

! • Logger Pro software 
! • Motion detector
! • LabPro Interface 
! • Number line on floor in metres (optional) 

To complete the next Activity, you'll need to set up the Motion 
Software to display both position vs. time and velocity vs. time 
simultaneously. To do this:

1. Clear data from any previous graphs

2. Pull down the Display Menu and select Two Graphs. 

Unit 3



3. Set the top graph to display Position from 0 to 4 m for 5 s.

4. Set the bottom graph to display Velocity from -1 to 1 m/s for 5 s.

✍Activity 3-8: Predicting Velocity Graphs from Position 
Graphs
(a) Carefully study the position graph shown below and predict the veloc-
ity vs. time graph that would result from the motion. Using a dashed 
line, sketch your prediction of the corresponding velocity vs. time graph 
on the velocity axes.
!
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(b) After each person in your group has sketched a prediction, test your 
prediction by matching the position vs. time graph shown.
When you have made a good duplicate of the position graph, sketch your 
actual graph over the existing position vs. time graph.

(c)Use a solid line to draw the actual velocity graph on the same graph 
with your prediction. (Do not erase your prediction).

(d) How would the position graph be different if you moved faster? 
Slower? 

(e) How would the velocity graph be different if you moved faster? 
Slower? 

Estimating and Calculating Velocity
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In this activity, you will estimate an average velocity from the ve-
locity graph you created in the previous Activity and then calcu-
late an average velocity using your position graph.

✍Activity 3-9: Average Velocity Calculations
(a) Find your average velocity from your velocity graph in the previous 
activity. Select Examine in the Analyze menu, read a number of values 
(say ten) from the portion of your velocity graph where your velocity is 
relatively constant, and use them to calculate the average (mean) veloc-
ity.

Velocity values  ____ ____ ____ ____ ____

from graph (m/s)
____ ____ ____ ____ ____

Average value of the velocity: ________m/s

Note: Average velocity during a particular time interval can also be cal-
culated as the change in position divided by the change in time. (The 
change in position is often called the displacement. ) By definition, this is 
also the slope of the position vs. time graph for that time period. As you 
have observed, the faster you move, the more inclined is your position vs. 
time graph. The slope of a position vs. time graph is a quantitative 
measure of this incline, and therefore it tells you the velocity of the ob-
ject.

(b) Use the method just described in the note to calculate your average 
velocity from the slope of your position graph in Activity 3-7. Use Exam-
ine (under the Analyze menu) to read the position and time co-ordinates 
for two typical points while you were moving. (For a more accurate an-
swer, use two points as far apart as possible but still typical of the mo-
tion, and within the time interval over which you took velocity readings 
in Activity 3-8.) 

Position (m) Time (sec)

Point 1

Point 2

(c) Calculate the change in position (displacement) between points 1 and 
2. Also calculate the corresponding change in time (time interval). Divide 
the change in position by the change in time to calculate the average ve-
locity. Summarize the results of your calculations below. 

Change in position (m)

Time interval (sec)
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Average velocity (m/s)

(d) Is the average velocity positive or negative? Is this what you ex-
pected? 

(e) Does the average velocity you just calculated from the position graph 
agree with the average velocity you estimated from the velocity graph? 
Do you expect them to agree? How would you account for any differ-
ences? 

Predicting Position Graphs from Velocity Graphs
The final challenge is to be able to produce position vs. time 
graphs from velocity graphs. In order to do this successfully, you 
need to know the position of the person or object of interest at 
least one of the times. 

✍Activity 3-10: Finding Position from a Velocity Graph
(a) Carefully study the velocity graph that follows. Using a dashed line, 
sketch your prediction of the corresponding position graph on the bottom 
set of axes. (Assume that you started at the 1-metre mark.)
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(b) After each person has sketched a prediction, do your group's best to 
duplicate the top (velocity vs. time) graph by walking. (Reset the Time 
axis to 0 to 10 seconds before you start.) When you have made a good 
duplicate of the velocity vs. time graph, draw your actual result over the 
existing velocity vs. time graph.
 
(c) Use a solid line to draw the actual position vs. time graph on the 
same axes with your prediction. Do not erase your prediction.

(d) How can you tell from a velocity vs. time graph that the moving object 
has changed direction?

 

(e) What is the velocity at the moment the direction changes? 

(f) Is it possible to actually move your body (or an object) to make verti-
cal lines on a position vs. time graph? Why or why not? What would the 
velocity be for a vertical section of a position vs. time graph? 

(g) How can you tell from a position vs. time graph that your motion is 
steady (motion at a constant velocity)? 

Unit 3



(h) How can you tell from a velocity vs. time graph that your motion is 
steady (constant velocity)? 
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